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To Use the Front Panel

You can use the dedicated front-panel knobs and buttons to do the most commonly performed operations.

Turn INTENSITY to adjust waveform intensity.

Push FastAcq to turn Fast Acquisition on and
off (CSA7000 and TDS7000 Series only).

Push CURSORS to turn cursors on and off.

Push PRINT to make a hard copy.

Push DEFAULT SETUP to return settings to the

default values.

Push AUTOSET to quickly set the vertical,

horizontal, and trigger controls for a
usable display. ~

Use the multipurpose knobs to control —<
parameters selected from the screen interface.
Push a FINE button to make small changes with
a multipurpose knob.

Push to turn the touch screen on and off.
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Push ZOOM to add a magnified graticule to the
display. Push the HORIZ or VERT button to
select the axis that you want to magpnify.
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Use these knobs and buttons to set horizontal
SCALE and POSITION for the waveforms. Push
DELAY to turn on horizontal delay, and then
use POSITION to set the delay time. Adjust
RESOLUTION to change the number of
acquired points in the waveform.
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Use these knobs and buttons to set the basic
trigger parameters. Push ADVANCED to display
a menu of additional trigger functions.

{——HORIZONTAL —/— 1= ——TRIGGER———
POSITION P D

Q
[e]
c
]
£
4
@
®
@
o
o
m

Oéé
IS

=
=)
o
m

NORM
AUTO

0 8

INTENSITY

[ STOP

ARM
READY
TRIGD

LE)
PUSH TC|SET 50%

/5
v

Use these buttons to start and stop
acquisition or start a single acquisition T

sequence. The ARM, READY, and TRIG'D
lights show the acquisition status. s

Turn channel displays on and off, and adjust the —»-<
channel POSITION and SCALE using dedicated
knobs and buttons.
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To Use the Screen Interface

You can control all oscilloscope functions except the power switch using only the screen interface.

Touch here to
change to menu bar
operation.

Choose the Toolbar

TS T &S W

Tek _Run

Touch a button in the toolbar to display a —
control window at the bottom of the display.

Ch1 Scale

50.0mY

Bandwidth

Touch a screen control to change a setting. ; ‘

Touch a numerical control to assign that control ———— e p——
to a multipurpose knob. Turn the multipurpose = =
knob to adjust the parameter value.

Touch here to change to
toolbar operation.

Choose the Menu Bar

Fie  Edt  “etea Horzideq  Tnig Disglap Cusors Measwe  Mashe  Math Ublkies

Pm Haorizantal/Acquistion Setup..

Use some menu items to — S
display a control window at the S Butoset g
. . 5 Wrde Lastfutaset . B |
bottom or side of the display. : N S — , : ;
e e D 1 [

; Delay Mode On i

Use some menu items to = f >+ Rollode Auto ;I

directly change settings. -. ¥ EaivdenTine Ao i ,

Position/Scale...
Resalution...
Acguisition Mode:

FastFrame Setup.. J Rk . ]

FastFrame Cohtrals. _
Display

Zoom Setup...

Zoom Graticuls b Zoom Source
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Touch here to close a
control window.

More Operating Tips:

m Use the touch screen to control the oscilloscope when bench space is
unavailable, such as on a cart or in an equipment rack.

m  Plug in a mouse and keyboard if you have the bench space to use them. You can
plug in a USB mouse or keyboard anytime, even while the oscilloscope is
running.

m  Use the menu bar to access PC-related functions, such as Page Setup, Export,
and Copy.



To Display a Waveform

Attach a probe to CH 1 and connect the probe f )
to your signal.
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To See More Waveform Detail

Use Zoom

Push the Zoom button to display a
zoom graticule.

Push the HORIZ button or the VERT button
to select the axis to magnify in the zoom
graticule. Use the multipurpose knobs to

adjust the position and magnification
factor of the zoomed waveform.

You can also set up a zoom graticule

from the screen interface. First touch and
drag across the segment of the waveform
that you want to see in greater detail.

Then select a zoom mode from the
drop-down list to magnify the highlighted
waveform segment.

Use Horizontal Delay

Push the front-panel DELAY button.

Adjust the delay time with the horizontal

POSITION control, or enter the delay time
in the control window.

Adjust the horizontal SCALE to acquire

the detail you need around the delay
expansion point.

Use the Zoom function to magnify an acquisition vertically, horizontally, or in both
waveform dimensions. POSITION or FACTOR changes that you make to the Zoom
graticule affect only the zoom display, not the actual acquired waveform. You can
select and lock together waveforms, and then scroll them automatically.
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Use horizontal DELAY to acquire waveform detail in a region that is separated from
the trigger location by a significant interval of time.
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More Operating Tips:

= You can use Zoom and Horizontal Delay together to magnify a delayed
acquisition.

m  Toggle Horizontal Delay on and off to quickly compare signal details at two
different areas of interest, one near the trigger location and the other centered at
the delay time.



To Use Fast Acquisition (cSA7000 and TDS7000 Series only)

Turn Fast Acquisition on to acquire up to 400,000 waveforms per second.

Push the front-panel FastAcq button. {1 —

Or select Fast Acquisitions in the
Horiz/Acq menu.

Adjust INTENSITY to optimize the intensity or
color grading for the signal being analyzed.
Increasing intensity can make less-frequently
acquired points brighter in the display.

How DPOs Work

Digital Phosphor Oscilloscopes (DPOs)
continuously acquire waveforms at rates
comparable to analog oscilloscopes. In
Fast Acquisition mode, DPOs
continuously overlay the acquired
information into a three-dimensional
database that is updated on the display
30 times per second. For each pixel in
the display, the intensity (or color) of the
pixel is proportional to the number of
actual samples that the pixel represents.

Horizdteq  Trig  Disg

Horizontal/Acquisition Setup...
Zoom Controls...

INTENSITY -

Whde Last Autaset

ZTRIGGER—/—

i
AL
) e

Bun#Stap...

3=

Delay Mode On
w Ball Mada dte

File  Edt  Metical Horzddeg  Tig  Oisglay Cuwsors Measwe  Mashe  Math Utlkies Help
ek 35t e 02 Wat 00 11:50:10

Ch1l Scale

400.0mY

|le1 ) ‘][I[IH"." —

Analog Real Time sweeps ——— A
Digital Storage acquisitions —— A\
Digital Phosphor acquisitions —— A

N J
Y

i

More Operating Tips:

m  Choose one of the color grading palettes in the Display Colors control window to
see different sample densities represented in different colors.

®  Turn AutoBright on in the Display Appearance control window. When you use
AutoBright, the displayed waveforms remain visible even at low trigger repetition
rates.



To Choose an Acquisition Mode

Select Horizontal/Acquisition Setup...in {1 —

the Horiz/Acq menu or touch the Horiz
button; then open the Acquisition tab.

Select an acquisition mode in the
horizontal/acquisition control window.

For Average or Envelope acquisition modes,
touch the # of Wfms control and then set the
number of waveforms with the multipurpose
knob. You can also double-touch the control

and use the pop-up keypad.

How the Acquisition
Modes Work

Sample mode retains one sampled point from
each acquisition interval.

Waveform Data Base mode takes an ensemble
of acquisitions that is best for accurate eye
pattern measurements.

Peak Detect mode uses the highest and
lowest of all the samples contained in two
consecutive acquisition intervals.

Hi Res mode calculates the average of all
the samples for each acquisition interval.

Envelope mode finds highest and lowest record
points over many acquisitions. Envelope uses
Peak Detect for each individual acquisition.

Average mode calculates the average value for
each record point over many acquisitions.
Average uses Sample mode for each individual
acquisition.
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To Select a Trigger

Select the EDGE trigger type and then set the ——

source, coupling, slope and mode with these
front-panel controls. Push ADVANCED to select
one of the other trigger types.

You can also select a trigger type in the Trig
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Or touch the Trig button and then select a —— HERTE ~ BT
trigger type in the trigger control window Trigger Type Sourc Edge Trigger
that is displayed. i Fattern ol v
,,E Coupling
Stale T
li' Force Trigger
. . ]
Trigger Selections
Trigger type Levels Timers Trigger conditions
Edge Single level None Trigger on rising or falling edge, as defined by slope
/; control. Coupling choices are DC, AC, AC LF Reject, AC
_ HF Reject, and Noise Reject.
Comm <X Depends on Coding None Trigger on telecom signals. Optional on TDS7000 series.
) ) Trigger on serial pattern data.
Serial nn Single level plus clock None Optional on TDS7000 series (not available on TDS7104 or
oo and bit pattern TDS7054).
Glitch Single level One to specify glitch Trigger on glitches narrower than the specified width or
j_\l—.ni width ignore glitches narrower than the specified width.
Width e Single level Two to specify minimum Trigger on pulses that have widths between the range of
4 \ and maximum pulse the two timers or outside the range of the two timers.
- widths
i One to specify an . - .
Runt Two levels to define the optional minimum Trigger on a pulse that enters the transition region from
logic transition region runt-pulse duration one side but does not leave the region from the other side.
Timeout Single level One to specify time-out Trigger when a signal does not make a transition for a
k time specified length of time.
Transition — Two levels to define the One to specify transition Trigger when a logic signal spends more time or less time
N logic transition region time in the transition region than a specified amount of time.
[
Setup/Hold ———— Independent levels for One to specify setup Trigger on violations of setup or hold time between a Data

Data and Clock

time and one to specify
hold time

signal and a Clock signal. The specified setup and hold
times can be positive or negative values.

Pattern Independent levels for One to specify pattern Trigger when a Boolean combination of up to four
%} each channel duration channels becomes true. Trigger immediately or only after
the combination is true for a specified time duration.
Independent levels for None Trigger on transition of one channel when a Boolean

State %]

each channel

combination of up to three other channels is true.




To Use the A (Main) and B (Delayed) Triggers

You can use the A Event (Main) trigger alone or combine it with the B Event (Delayed) trigger to capture more complex signals.

Set the A trigger type and source in
the A Event (Main) tab of the trigger
control window.

Choose a function in the A—B Sequence tab of 2
the trigger control window.

Set the trigger delay time or the number 3

f:Edge — Trigger After Time — BiEwent — fcquire

A-=B Sequence Horizontal Position

& Only (DGl LT 50,0

CEEET B Trig Level

0.0
Trin After i
Time ith event Trig Delay

I f\_{—; 16.0ns

of B events, as appropriate.

Set the B trigger characteristics in the B Event 4 ——
(Delayed) tab of the trigger control window.

Trigger on B Event

The A trigger arms the oscilloscope.
Posttrigger acquisition starts on nth B event.

B Trigger After Delay Time

The A trigger arms the oscilloscope.
Posttrigger acquisition starts on the first B
edge after the trigger delay time.

Pretrigger Posttrigger
record record
Aftrigger point |<— Ac?uired waveform record —>|
Atrigger y |
source | |
I
B trigger W&K
source \ ¥
Waiting for nth trigger point
event (Where n=5)
Atrigger point
| |
Atrigger \ﬁILllﬂﬂﬂﬂJﬂJﬂﬂﬂﬂﬂﬂﬂﬂ_ﬂﬂ
source | I I
INNINININT N E NN N
B trigger | ~—]
source Trigger
< . .
delay time B trigger point

More Operating Tips:

m  B-trigger delay time and horizontal delay time are independent functions. When
you establish a trigger condition using either the A trigger alone or the A and B
triggers together, you can also use horizontal delay to delay the acquisition by an
additional amount.

= When using the B trigger, the A trigger can be any of the following types: Edge,
Glitch, Width, or Timeout. The B trigger type is always Edge type.



To Perform Mask Testing
(CSA7000, optional on TDS6000 and TDS7000 Series)

Masks Mat Source Tolerance
Select Mask Setup in the Masks menu. 4 aml Standard - Yer 1.01
bazk Type... k

Choose a mask type. 9 Source..
Tolerance Setup...
Pazs/Fail Setup. .
Pas2/Fail Results...

Mask On

bdazk Controls...

FCA063 Dptical,
3 5

Mazk Configure 3

ptical |p.12E

Maszk Edit Setup...
Mazk Edit Controls. .

Choose a mask standard. 3

IR

[y Alignment

Select Autoset to automatically set up the [ — et

controls based on the input signal.

Optionally select Autofit to align each § —
acquired signal with the mask to
minimize the number of hits.

Use the Source tab to select the source of
your signal.

Use the Tolerance tab to increase or decrease rce ( Tolerance )
the mask margin used in mask testing.

Mask Margin Tolerance

Margins




To Set Up Mask Pass/Fail Testing and View Results
(CSA7000, optional on TDS6000 and TDS7000 series)

Use the Pass/Fail Setup tab to set up Pass/Falil
testing.

Use the Passj/Fail controls to start, stop, or
continuously run a mask test.

Use the Polarity controls to select testing the 3

positive, negative, or both the positive and
negative pulses.

Enter the number of waveforms to acquire and
use in your mask test.

Enter the number of waveforms that must fail to
consider the test a failure.

Enter the time that the instrument delays before
starting the mask test.

Use the Pass/Fail Test Notification controls
to select how you want to be notified when
a failure occurs and when the

mask test completes.

Masks

# of Wims

Fail Thresh

1]

Pass{Fail Test Hotifications
Failure Completion

Stop Acy Beep

Test Delay *
o

# of Wims
20

Fail Thresh

# of Wfms field changes to # of Samples field.

1]

Test Delay

PassiFail Test Maotifications

Completion
Beep

Failure

When using masks that enable the Waveform Database mode, the

Use the Pass/Fail Results tab to view the
results of your mask testing.




To Take Automated Measurements

Touch the Meas button, and then select up to ———=J Meas |
eight measurements using the measurement
control window.

Source

Measurements

Use the tabs to choose measurements in
the various categories.

Or choose a measurement for the selected

Measure

b ashks

Measurement Setup...

Snapshot. .

Amplitude » High Lewel

Tirme 3 Lo Lewel

LComm k LAmplitude

bore 3 G ER
o Miirurn

Statistics r

waveform directly in the Measure menu.

Reference Levels. .

Peak to Peak
Pos Owershoot
Heq Owershoot

Mean Chi

Pk-FPk

Rise Time |Chi

Delay
Freq

Rise Time

Annotation
Meas 1 W

Gating.. Mean
“weaveform Histograms... RMS
F eset Histogram Cycle Mean
Histogram Measurements Cyele RS
Automated Measurement Selections
Amplitude Time More Histogram Comm
P 9 (Optional for TDS6000 and TDS7000 series)
I O VA R B IS v A
Amplitude Max Rise Time P\?VSI(I};\IIIB Area (\:’Y)LTn Max ExtRatio Eye Height Eye Top
High Min - Negative Hits in - i Eye Width Eye B
Fall Time V\!IJidth Cycle Area Box Min Ext Ratio % ye Wid ye Base
nr e | A A
ositive ea _ : P
Low Pk-Pk Duty Cycle | Duty Cycle Phase Hits Pk-Pk Ext Ratio (dB) | Crossing %
RMS Cycle Period Burst . . . I
NS erio Delay Width Median Mean Jitter P-P Noise P-P | Cyc Distortion
Positive .
Overshoot Mean Frequency Std Deviation | 20 Jiter RMS | Noise RMS | Q-Factor
— | 27 A A
Negative Cycle . i
Overshoot Mean u=lo w =30 Jitter 60 S/N Ratio




To Customize an Automated Measurement

Use Gating to confine the measurement
to a certain portion of the waveform.

Turn on measurement statistics to
characterize the stability of the measurement.

High Ref Mea

Period : 8
Pos Width Heq Width :
Burst Wid

Adjust the measurement reference levels to e Mig:he i

different relative or different fixed values. - s e S

Min Low:

Low Ref et T

10 RMS Cycle RMS :
Area GCyc Are

Select snapshot to see a one-time view of
all valid Normal or Comm measurements.

To Set Up a Histogram

M. . Zoom 1 0n
Zoom 2 0n

. ’ . Zaoom 30n
Touch and drag across the segment of the { ——— . \\ R
waveform that you want the histogram to cover. : AN
To set up a horizontal histogram, for example, : : . Messurerk n G atng Cureor
make the box wider than it is tall. Heasrenjin Belia Z5em

Zoomar
. ) . Histagran |31
: : ol | G et O

Cancel

Select Histogram Horizontal from the 9
drop-down list.

Trg  Display  Cursors

View the histogram at the top or edge of
the graticule.

If you need to make any adjustments to the 4 Waveform Histagram
histogram, use the histogram setup control Source Histogtam - istogram
ode

window. Select Waveform Histograms in the Rt o o
Measure menu.

Log

Take automated measurements on histogram § ;' 160 0 st
data. See previous page for information. : , b e




To Take Measurements With Cursors

Push the front-panel CURSORS button. 1 Cursor Source

Select the waveform you want to measure and 2
a cursor type in the cursor control window.

Or you can activate cursors on the selected
. . C 4
waveform directly in the Cursor menu. —_—

LCursor Controls... ‘

Curzgorz On

H-barz

Wwaveform

Curzor Pogition...
Screen

Setup

Curzor Setup...
cursor 1 cursor 2
Source Source
Push Setup and place cursors withthe § ——— Ch1 % Cha w
multipurpose knobs or enter the cursor
locations numerically. % Position ¥ Position
-B0.0ns 0.0ns
If you choose Waveform cursors to take 4
measurements between waveforms,
select the source for each cursor. S _ _ T _ T1: 356.4 ms
i : : : . : : T2: 352.5 ms
AT:3.92 ms
1/AT: 255 Hz
V1:5.120V
V2: 4.886 V
AV: 234 mV
AV/IAT: 59.7 V[s
S

Read cursor measurement §
results in the display.

Other Cursor Measurement Tips:

®  You can set the cursors to move together in tandem if you choose the Tracking
cursor mode. The cursors move independently if you choose the Independent
cursor mode.

= [f you use the zoom graticule, you can place a cursor directly on a specific
waveform point to take precision measurements.

®  You can also move cursors by touching or clicking them and then dragging them
to a new position.



To Use Math Waveforms

Math  Utities (Math )| Mathz | hath3 | Matha
Select Math Setup in the Math menu. { — Mathl = GhivCh2
Display On/0f.. . Define/Edit Expression
Bosition/Scale... Display
Label...
Ch1 -Ch2
Ch3 - Chd
Chl = Ch2
Ch3 * Chd Label
Choose one of the predefined math equations. 2 TR

Phaze Spectum
Spectral Contrals..

Set Math Averages

Equation Editar...

Or touch Editor to define a more advanced math ‘

waveform. Then build the waveform expression
using sources, operators, constants,
measurements, and functions.

Tert Log 10
Loge

Ifore

To Use Spectral Analysis 1

Mfath 1 W -
In the Math menu, select Spectral Controls to )

define FFT magnitude and phase waveforms.

When an FFT waveform is selected, you can Adjust FFT center

use the multipurpose knobs to adjust the FFT seasen 0 frequency
waveform just as you would using a spectrum —
analyzer. Res BW
L ~—— Adjust FFT span

Ref Level
20.0dB

Setup Close

You can view time-domain and
frequency-domain waveforms
simultaneously. You can also use
gating to select only a portion of the
time-domain waveform for spectral
analysis.




To Store Information

To Save and Recall Waveforms — D |
Eef : Reference Setup...
To save or recall waveforms, select 1 — g:::r;g;jj;ggu Display Onvf.. r
Reference Waveforms and then Save Wfm... or = P BositondScale.

Run Application » Label...

Recall Wfm... in the File menu.

=T S

Pnr;l Preziz;,w ava All'\wims

Or touch the Refs button. S G BecuUim
Ezport Setup... Delete All Refe

Use the reference setup control window to copy 3
a live waveform into one of four nonvolatile Save Wim to Refl Recall Ref1 from

reference waveform storage locations. You can Position () [ Ch A e
also display these waveforms as reference iy = | Regall
waveforms. Save Wim to File Delete Wim File
Ml

Label L]
L [afete
ref2 lahel

Select Save Wfm to File to store the live
waveform as a file on a disk drive. You can
recall a waveform stored on disk into one
of the internal reference waveform
locations for display.

To Save and Recall Instrument

setups File  Edit @

Beference Wavefoms 3
To save an instrument setup, select 1 — Instrument Setup...
Instrument Setup in the File menu.

Recall Default Setup

Run Application 3

Or touch the Setups button.

Save Settings from Local Memory
Save Settings

Use the settings control window to save the +5 Check B3 - e strove Y - Factow to File
current setup into one of ten internal storage
locations. Use the pop-up keyboard to label the —— - -
. e Clock .Jitt Factory Factory
setups for easy identification. e N - Fecton B - Fecton
Or select Save Settings to File to store the Setup Time Factory
current setup on a disk drive. You can recall any
setup stored on disk and then save it in an Jata Blus Factory
internal setup storage location for
quicker access.
To restore the oscilloscope to a known initial state, 3 — Bl Edt Vi
push the front-panel DEFAULT SETUP button. Reference Waveioms v
Instrument Setup...

Or select Recall Default Setup in the File menu.

Fun Application 3 |




To Print a Hard Copy

To print a hard copy to an attached printer ora ———

network printer, push the front-panel PRINT
button.

PRINT

Or select Print in the File menu. If necessary,

File  Edt

Beference W aveformns
Instrument Setup.. .
Recall Default Setup

Fiun &pplication

Page Setup...
Frint Presie

you can make changes to the page orientation
in the Page Setup dialog box.

The Page Setup dialog box also includes ———»

selectors for the print palette and a feature
called Ink Saver. Ink Saver optimizes the
display colors and shades for printing hard
copies on white paper.

' Calar
" GrapScale
" Black & white

Funmrt Sehin

FPalette——— View

% Full-Screen

" Graticulz(z] Drly

[ Set Print button to Expart

To Copy or Export Your Results

You can use the Windows clipboard to ——
copy information. Simply select the item
to copy, copy it, and then paste it into
another Windows application.

Edit  Yertical

UhdeLastsutaser ‘

LCopy Chl+C

Screen (bitmap)

Graticule [bitmap)

Copy Setup. ..
By SR W avebarm [data)

Meazurement [data)

ELX-3564 System Controller Test Report
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You can export waveform data into a comma- » -1%20379613,-1400249222, -1407839845, -1415300200,

separated ACSII file for use in a spreadsheet or
data analysis program. Select Export Setup in the
File menu to set the output content and format
for images, waveforms, or measurements.

—-14226295596, -1429527356, -1436592513, - 1443825313,
—-1479636700,-14572855891, -1463518722, -1529021630,
—-15207655593,-15415896902, -1458577715, - 14594424516,
—-1500133037,-1505702749,-15111331559,-151642370&,
—-1521573950,-15265853406,-1531451606,-1536178099,
—-1540762450,-1545204233, -1549503037, -1553 658465,
—-1557670132,-15615357666,-1565260711, -15688385922,
—-1572271966,-15755559525, -1578701302, -15516965995,
—-15584546339,-1587245060, -1559504913, -1592213660,
—-1594475079, -1612554549, -1598555107, -1600373340,

—1EN?N42400 188770801 A 1 ENd0ea03? _1&NE1 Srace



To Run Application Software

You can install and run optional application software on your oscilloscope. These software packages provide advanced capability
supporting many applications. Two examples are shown below; additional packages may be available. Contact your Tektronix
representative for more information.

@ G W O D O D

[ Tek Run Sample

M40.0n3 £.0634 0.
A Ch3 o~ 106m ¥ B

Inputs: Main

characterize timing performance. Analyze
jitter on contiguous clock cycles using
single-shot acquisitions.

Hysteresis &

A0my

hid:
Gating Off

File  Edt  Verical Horizthcq  Trig  Display  Cursors Measre  Masks  Math  Utities  Help

50.0m ¥ Q ¢ ¥ M2000s 25655 °
B # Chi r 632m ¥

Use TDSDDM Disk Drive Measurement —————>-£ Hessuemerts naue View Pt op Hele
Software to measure disk drive signals . o

according to IDEMA standards. : * ; |

Rez:flgnal Sm:::rE Puls: Lo St J‘

Mode
Preamble  # StopSector #

e e ¢ (EEEDTEE

Read Gate Index Pulse

ch2 ¥ chy  w

File  Edi

Bsference W avetamms »
Inztrument Setup..
Fecall Default Setup

Follow the instructions provided with the ——— |l BT

application software to install it. To run
the software, select the application in the Page Setp...

File / Run Application menu. Fint Previevt
Fiint... Chrl+F

Ezport Setup. ..
Select for Esport 3
Ewport... Chrl+E

1 0203206_213146. set

Minimize Ctrl+hd

Shutdovn. ..




To Connect to a Network

Like any other Microsoft Windows-based g 7
computer, you can connect the oscilloscope = =
to a network to enable printing, file sharing, ! ! 7
internet access, and other communications ] Network
functions.

To make a network connection, consult with
your network administrator, and then use the
standard Windows utilities to configure the
oscilloscope for compatibility with your
network.

[[Textronix
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o om 00

@
=
(@]
o

0 0 000000
(0} 00 Ooom

@

To Use a Dual Monitor

Connect a keyboard, mouse, and monitor to (ons )

the oscilloscope and configure Windows for E CT
dual-monitor mode. You can operate the
oscilloscope while having full use of
Windows and other installed applications on
the external monitor.

;

o |00 om 00

0

Ne mobD @

0 0 00000
00 00000

Connect the monitor to the upper SVGA port
on the oscilloscope rear panel. Use the
Settings tab in the Windows Display
Properties dialog box to set up a
dual-monitor configuration.




To Access the Help System

Touch the HELP button or select Help on ——

Window in the Help menu to receive
context-sensitive help on the current setup.

Select Contents and Index inthe Helpmenuto F

access any topic in the help system. Select the
topic, and then touch the Display button in the
dialog box.

Touch an outlined control shown in the help
window to receive more specific information
about the control.

Touch a tab in a help window to navigate
between the Overview and specific topics.

Touch the Minimize button in a help window

to move help out of the way so you can
operate the oscilloscope. Touch the Restore
Help button to see the last help topic again.

dath  Ltilities

LContents and |ndes...
Hestare HEln

Specific ationz....
Technizal Support...
Customner Feedback...

About TekScope...

verview
Help Topics[  Back Dptions « 25 LClose Minimize
Offset
Overview Y Display ¥ Position & Scale Y Offset N
ToUse

Use the Verlical Offset cortrols to st the offset value of the selected
wawetorm to shiftthe vertical aceuistion window to match the wave
form data you veant 1o aceire,

Touch a channel tab at the top of the control window to select the vertical input channel. Touch the
offset control to map it to one of the muttipurpose knobs, and then use the knob to set the offset
wvalue.

Behavior
Use the nffset cortralto elminate cligping the wavetorm. The aftsst control affects the vertical
acquisition window by subtracting & DC bias from the waveform. This moves the level at the vertical
center of the acquisition window of the selected channel. Visualize offset as scroling the
acuistion window towerds the top of & large signal for increased offset values and scroling
towards the bottom for decreased offset values.

The oftset control atfects the display of the wavatorm by tefining the channel retersnce indicator
to match the affset rather than the oround level, The oftset atfects only channel wavetonms as
compared to the position control that affects all waveforms, inclucing math and reference
waveforms

What do you want to do next?

J Continue to learn about the vertical setup controls.

Help Topics: CSA7000 Series Oscilloscopes

Contents | indes | Find |

Click a topic, and then click Display. Or click another tab, such as Index

HE

(1) Intioducing the CSA7000 Series Dsciloscope
[2] About the CSATO00

(2] Specifications
[2] Using the online help
@ hccessonies

@ Front Parel

@ Screen nterface

@ Howto ?

@ Open Desktop

@ Rear Panel

@ Reference Infomation

Display Bt

Cancel

Vertical Setup Control Window
Aecess this control window from the Vertical menu

Overview Y/ Display Y Posftion & Scale

Y Difset .

Control Window Overview

Use these controls to set the vertical parameters for live (o
each channel are independent; use the tabs &t the top of tt
channel you wart to change

For more information on & cortrol, touch one of the outlined

— iti
“ - - Position & Scale

‘ulrn'l tinn {1

Display Offset Termination  Cc

KIS

Each wavetorm slso has ts own v[rtical scale control. For & signal with a constar
ampitude, incressing the scale cau[es the waveform to be displayed smallsr. Decr [asing the
seale causes the waveform to be i splayed larger.
For channel wavetorms, the scale [etting controls the vertical size of the acquisitio|s window
as well a3 the display scale. The re[ige and resolution of the scale value depends cf1the

attacted probes and on any other [xernal factors you may have specified

&
WTIP Lse the dedicated knob on |ve front panel to control the position and scale cf the

b Display Y Position & Scals Offs | £ .

To Use ﬂ

Use the Fssition contral to set the vertical postion of the v|aveform an
the scree|1. Use the Scale control window to control the v[irtical scale
of the weseform. Touch the controls to map them to the 1| ipurpose:

knobs, ar [{ then use the knobs to change the waveforms

Behavioi
Each war[sform has ts own vertical position control. The |ontrol

incremer [: or decrements the vertical postion of the wav |form one
pixel at & | me. Increasing the position value of the wavefc|m moves
the wawe |orm up, and decreasing the position moves the [vavetorm
down

I

‘What do you want to do next?

Aestore Help |




Front Panel Inputs and Outputs

CSA7404 i

CSA7154

—— Floppy disk drive accessible
from Windows

® 0O ©

Probe compensator output to compensate 4%#

and deskew probes J

Recovered clock output
Recovered data output

Optical input to O/E converter

Electrical output from O/E converter

Channel inputs

TDS6404 [

TDS6604
TDS7404
TDS7254
TDS7154

i
\ 0

0lo
0'p

000

Ooo

0 000000
0|00 oomp

O
O
o

0
O

g
O

om am 00

) [ ————<—-—— Floppy disk drive accessible

from Windows

0O MO0 O

O

B
Probe compensator output to compensate ® ®

®

B B & B

and deskew probes J

Auxiliary input to provide an external
trigger input

Auxiliary output to provide trigger

output signal
Analog signal output from the CH 3 input

-

Channel inputs

044— Ground terminal
J

TDS7104 [

TDS7054

Probe compensator output to
compensate and deskew probes. ‘

0'p

om om 00

O mODO

=
g2
EE
8
g

So
S3

—— Floppy disk drive accessible
from Windows

omaQ

Auxiliary input to provide 4%%@@ @ oﬂ— Ground terminal

an external trigger input

Auxiliary output provides trigger
output signal

Analog signal output from the CH 3 input

Channel inputs



Rear Panel Inputs and Outputs

Removable hard disk drive to provide
individual environment for each user or to
secure data; press cover to release the disk

CD-RW drive accessible from Windows; —— d%‘*&

ress cover to open the drive
p p =
R
USB connector for mouse, keyboard, or other T oo
peripherals

PS-2 connector for mouse

PS-2 connector for keyboard

Upper SVGA port to connect a monitor for »{OJ\| ool @
dual-monitor operation

Lower VGA port to replicate the oscilloscope display

on an external monitor
Lt}

IEEE STD 488 PORT

Parallel port (Centronics) to —>@&\ooooooooooooo}@ < ->
. i OO0OO0O0O0O0OOO0OO0OOO0O0

connect printer or other device

GPIB port to connect to controller

&5

RJ-45 connector to connect to network B

cou |OIO]
olEz)e
0000

COMT serial port

Connectors for speaker and microphone —»@ A@

A

OJOJONOKO

H_/
CSA7000 only: Auxiliary (external trigger) 4

input, Auxiliary (trigger) output signal,
Analog (CH 3) signal output

External reference input and
internal reference output



Recommended Probes and Accessories

CSA7404, CSA7154,
TDS7404, TDS7254, TDS7154,
TDS6000 Series .,
P7240 4 GHz Active Probe for P7260 6 GHz 5x/25x Active
general-purpose applications Probe
CSA7000 only. O/E-to-TekConnect and
O/E-to-SMA adapters for O/E converter
TCA-SMA, TCA-BNC 5022, and TCA-N TCA-1MEG Buffer Amplifier to connect
adapters for your probes and cables 1 MQ accessories
TDS7104, TDS7054

P6139A Passive Probes for P6243 and P6245 Active Probes or P6158
general-purpose applications Low-C Probe for high-speed applications

P6247 and P6248 Differential Probes for TCP202 Current Probe for
differential signals and low-noise applications general-purpose applications
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